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1.  INTRODUCTION

The Intellicom intelligent terminal interface is a high-perfor-

mance, C-programmable terminal that offers built-in I/O and

Ethernet connectivity. A Rabbit® 2000 microprocessor operating

at 18.5 MHz provides fast data processing.

1.1  Features

• C-programmable to create a custom user interface

• 4 protected logic-level digital inputs

• 4 protected sinking digital outputs

• High-visibility backlit 4 × 20 LCD

• 10Base-T Ethernet interface

• TCP/IP capability

• RS-232 and RS-485 serial ports

• 128K SRAM and 256K–512K flash EPROM

• Self-healing lens is scratch, impact, and abrasion-resistant

• Real-time clock

• Watchdog supervisor

• Voltage regulator

• Backup battery

• Can be programmed to emulate a serial terminal

• Splash-resistant when panel-mounted using the supplied gasket

• Can be wall-mounted or panel-mounted

Appendix A provides detailed specifications for the Intellicom.
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Two versions of the Intellicom are available. Their standard features are summarized in 

Table 1.

Both models are available with a vacuum fluorescent display instead of the LCD.

Visit our Web site for up-to-date information about additional add-ons and features as they 

become available. The Web site also has the latest revision of this user’s manual.

Table 1.  Intellicom Series Features

Model Features

OP6600
Standard terminal without Ethernet interface and only 

256K flash EPROM.

OP6700
Full-featured terminal with Ethernet interface and 512K 

flash EPROM.
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1.2  Development and Evaluation Tools

1.2.1  Tool Kit

The Tool Kit has the essentials that you need to understand and program your own Rabbit-

based display unit.

The items in the Tool Kit and their use are as follows:

• Intellicom Getting Started instructions.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Demonstration Board. The Demonstration Board includes pushbutton switches and 

LEDs, and can be connected to the Intellicom board. Programs that run on the Demon-

stration Board can be used to flash the LEDs and otherwise demonstrate the capabilities 

of the Intellicom terminal.

• Programming cable. The programming cable is used to connect your PC serial port to 

the Intellicom to write and debug C programs that run on the Intellicom board.

• Wire assembly to connect Intellicom board to Demonstration Board.

• Screwdriver.

• Universal AC adapter (includes Canada/Japan/U.S., Australia/N.Z., U.K., and Euro-

pean style plugs). The AC adapter is used to power the Intellicom board. A power supply 

of 12 V at up to 500 mA is recommended. The Intellicom can also be powered from 

any DC voltage source between 9.0 V and 40 V.

1.2.2  Software

The Intellicom is programmed using Rabbit’s Dynamic C. A compatible version is included 

on the Tool Kit CD-ROM. Dynamic C v. 9.60 includes the popular µC/OS-II real-time oper-

ating system, point-to-point protocol (PPP), FAT file system, RabbitWeb, and other select 

libraries that were previously sold as individual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our Web site at 

www.rabbit.com for further information and complete documentation, or contact your 

Rabbit sales representative or authorized distributor.
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1.3  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequencies 

above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based 

systems at frequencies above 300 MHz are generally well below background noise levels.

The OP6700 operator interface has been tested and was found to be in 

conformity with the following applicable immunity and emission stan-

dards. The OP6600 operator interface is also CE qualified as it is a sub-

version of the OP6700 operator interface. Boards that are CE-compli-

ant have the CE mark.

NOTE: Earlier versions of the Intellicom sold before 2003 that do not have the CE mark 

are not CE-complaint.

Immunity

The Intellicom series of operator interfaces meets the following EN55024/1998 immunity 

standards.

• EN61000-4-2 (ESD)

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The Intellicom series of operator interfaces meets the following emission standards emis-

sion standards with the Rabbit 2000 spectrum spreader turned on and set to the normal 

mode. The spectrum spreader is only available with Rev. C or higher of the Rabbit 2000 

microprocessor. This microprocessor is used on the Intellicom operator interfaces that 

carry the CE mark.

• EN55022:1998 Class B

• FCC Part 15 Class B

Your results may vary, depending on your application, so additional shielding or filtering 

may be needed to maintain the Class B emission qualification.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m
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1.3.1  Design Guidelines

Note the following requirements for incorporating the Intellicom series of operator inter-

faces into your application to comply with CE requirements.

General

• The power supply provided with the Tool Kit is for development purposes only. It is the 

customer’s responsibility to provide a CE-compliant power supply for the end-product 

application.

• When connecting the Intellicom to outdoor cables, the customer is responsible for pro-

viding CE-approved surge/lighting protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices.

• When installing or servicing the Intellicom, it is the responsibility of the end-user to use 

proper ESD precautions to prevent ESD damage to the Intellicom. 

Safety

• All inputs and outputs to and from the Intellicom must not be connected to voltages 

exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the Intellicom has been designed to protect the 

battery from hazardous conditions such as reverse charging and excessive current 

flows. Do not disable the safety features of the design.

1.3.2  Interfacing the Intellicom to Other Devices

Since the Intellicom operator interfaces are designed to be connected to other devices, 

good EMC practices should be followed to ensure compliance. CE compliance is ulti-

mately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our Web site at www.rabbit.com.
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2.  GETTING STARTED

Chapter 2 explains how to connect the power supply to the Intel-

licom board and how to connect the programming cable from

the Intellicom board to your PC. Once you run a sample pro-

gram to demonstrate that you have connected everything cor-

rectly, you will be ready to go on and finish developing your

system.
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2.1  Power Supply Connections

1. Remove and set aside outer casing and rubber gasket.

Before proceeding, remove and set aside the outer casing, rubber gasket, screws, and 

panel-mount brackets included with your Intellicom unit, shown in Figure 1. The outer 

casing and rubber gasket are not attached to the front panel when the Intellicom is shipped. 

Take care not to damage the rubber gasket.

Figure 1.  Remove and Set Aside Outer Casing and Accessory Parts

2. Position Intellicom board.

The Intellicom board is attached to the back of the front panel. Turn the front panel assem-

bly over so that the Intellicom board is facing up as shown in Figure 2.

Figure 2.  Power Supply Connections
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Connect the positive lead (indicated with red heat-shrink tubing on the AC adapter 

included with the Tool Kit) to the PWR connector on header J7 on the Intellicom Board 

and connect the negative lead to GND on header J7 as shown in Figure 2 and Figure 3.

CAUTION: Be careful to hook up the positive and negative power leads exactly as 

described. Otherwise, the Intellicom board will not function.

4. Apply power.

Plug in the AC adapter. The Intellicom board is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the AC adapter, then plug-

ging it back in.

3. Connect Power Supply to the Intellicom 

Board

First, prepare the AC adapter for the country 

where it will be used by selecting the plug. The 

Intellicom Tool Kit presently includes Can-

ada/Japan/U.S., Australia/N.Z., U.K., and Euro-

pean style plugs. Snap in the top of the plug 

assembly into the slot at the top of the AC adapter 

as shown in Figure 2, then press down on the 

spring-loaded clip below the plug assembly to 

allow the plug assembly to click into place.
Figure 3.  Power Supply Connections—

Detailed View
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2.2  Demonstration Program on Power-Up

The following sequence of messages will be displayed on the LCD when power is first 

applied to the Intellicom board. Note that the programming cable must not be connected.
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The contrast, backlight, speaker volume, and cursor positions will change automatically 

through the demonstration. Then there is an opportunity for you to vary these settings by 

responding to prompts on the LCD.

This demonstration will be replaced by a new program when the programming cable is 

attached and the new program is compiled and run. The demonstration is available for 

future reference in the Dynamic C SAMPLES directory as ICOMDEMO.C.

1. Choose which feature (LCD con-

trast, backlight on/off, speaker, or 

cursor) you wish to change.

2. Press [1] to select the contrast 

adjustment demonstration.

3. Press [1] to increase contrast, press 

[6] to decrease contrast, or press 

[Enter] to get to choose another 

feature.

4. Press [2] to select the backlight 

demonstration. Press [2] to toggle 

backlight on or off, or press [Enter] 

to get to choose another feature.

5. Press [3] to select the speaker dem-

onstration. Press [1]–[4] to set the 

desired speaker volume ([1] is min, 

[4] is max), press [5] or [0] to 

increase or decrease frequency, or 

press [Enter] to get to choose 

another feature. The volume and 

frequency are displayed.

6. Press [4] to select the cursor dem-

onstration. Press keys as shown to 

move cursor, or press [Enter] to get 

to choose another feature.
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2.3  Programming Cable Connections

1. Connect the programming cable to the Intellicom board.

Connect the 10-pin PROG connector of the programming cable to header J4 on the Intelli-

com board as shown in Figure 4. Be sure to orient the red edge of the cable towards pin 1 of 

the connector. (Do not use the DIAG connector, which is used for a normal serial connection.)

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. 

Carefully pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an 

RS-232/USB converter (Part No. 20-151-0178) with the programming cable supplied 

with the Intellicom Tool Kit. Note that not all RS-232/USB converters work with 

Dynamic C.

Figure 4.  Programming Cable Connections

NOTE: Be sure to use the programming cable (Part No. 101-0513) supplied with the 

Intellicom Tool Kit—the programming cable has red shrink wrap around the RS-232 

converter section located in the middle of the cable. Programming cables from other 

Rabbit kits are not designed to work with the Intellicom.

2. Apply power.

Reset the Intellicom by unplugging the AC adapter, then plugging it back in. The Intelli-

com board is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the AC adapter, then plug-

ging it back in.

To power down the Intellicom, unplug the AC adapter. You should disconnect power 

before making any circuit adjustments or changing any connections to the board.
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2.4  Installing Dynamic C

If you have not yet installed Dynamic C, do so now by inserting the Dynamic C CD from 

the Intellicom Tool Kit in your PC’s CD-ROM drive. The CD will auto-install unless you 

have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and 

browse for the Dynamic C setup.exe file on your CD drive. Click OK to begin the 

installation once you have selected the setup.exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-

lation of the later version will be in a different folder, and a separate icon will appear on 

your desktop.
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2.5  Starting Dynamic C

Once the Intellicom is connected to your PC and to a power source, start Dynamic C by double-

clicking on the Dynamic C icon on your desktop or in your Start menu.

If you are using a USB port to connect your computer to the Intellicom, choose Options > 

Project Options and select “Use USB to Serial Converter.” Click OK.

Dynamic C defaults to using the serial port on your PC that you specified during installa-

tion. If the port setting is correct, Dynamic C should detect the Intellicom and go through 

a sequence of steps to cold-boot the Intellicom and to compile the BIOS. (Some versions 

of Dynamic C will not do the initial BIOS compile and load until the first time you com-

pile a program.)

If you receive the message No Rabbit Processor Detected, the programming 

cable may be connected to the wrong COM port, a connection may be faulty, or the target 

system may not be powered up. First, check both ends of the programming cable to ensure 

that it is firmly plugged into the PC and the programming port with the marked (colored) 

edge of the programming cable towards pin 1 of the programming header.

If there are no faults with the hardware, select a different COM port within Dynamic C. 

From the Options menu, select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate the 

active COM port. You should receive a Bios compiled successfully message 

once this step is completed successfully. 

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Choose a lower debug baud rate.
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2.6  PONG.C

You are now ready to test your set-up by running a sample program.

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, 

open it with the File menu (if it is not still open), compile it using the Compile menu, and 

then run it by selecting Run in the Run menu. The STDIO window will open and will dis-

play a small square bouncing around in a box.

This program does not test the serial ports, the I/O, or the TCP/IP part of the board, but 

does ensure that the board is basically functional. The sample program in Section 5.5, 

“Run the PINGME.C Demo,” tests the TCP/IP portion of the board.
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2.7  Where Do I Go From Here?

NOTE: If you purchased your Intellicom through a distributor or Rabbit partner, contact 

the distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to explore other Intellicom fea-

tures and develop your own applications.

Chapter 3, “Subsystems,” provides a description of the Intellicom board’s features, 

Chapter 4, “Software,” describes the Dynamic C software libraries and introduces some 

sample programs, and Chapter 5, “Using the TCP/IP Features,” explains the TCP/IP fea-

tures.
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3.  SUBSYSTEMS

Chapter 3 describes the principal subsystems for the Intellicom.

• Intellicom Subsystems

• Serial Communication

• Memory

• Speaker

• Other Hardware
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3.1  Intellicom Subsystems

Figure 5 shows the Rabbit-based subsystems designed into the Intellicom.

Figure 5.  Intellicom Rabbit-Based Subsystems

The Intellicom board has 15 pins on header J7, one RJ-12 jack for RS-232 or RS-485 

serial communication, and one Ethernet jack (OP6700 only). The pinouts are shown in 

Figure 6.

Figure 6.  Intellicom I/O Pinout

RJ-45 pinouts are sometimes numbered opposite to the way shown in Figure 6. Regardless 

of the numbering convention followed, the pin positions relative to the spring tab position 

(located at the bottom of the RJ-45 jack in Figure 6) are always absolute, and the RJ-45 

connector will work properly with off-the-shelf Ethernet cables.
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3.1.1  Digital Inputs

Pins 8–11 on header J7 have the four digital inputs IN0–IN3. Each of the four digital 0 V 

to 5 V inputs is protected over a range of –36 V to +36 V. The Intellicom is factory-config-

ured for the digital inputs to be pulled up to +5 V, but the digital inputs can also be pulled 

down by moving the surface-mounted jumper at JP4. The jumper settings and the location 

of JP4 are shown in Figure 7.

Figure 7.  Surface-Mounted Jumper Configurations for Selecting

Pullup/Pulldown on the Digital Inputs

3.1.2  Digital Outputs

Pins 12–15 on header J7 have the four digital outputs OUT0–OUT3. Each of the four 

open-collector digital outputs can sink up to 200 mA at 40 V DC. 
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3.2  Serial Communication

In the factory-default configuration, the Intellicom has one RS-232 (3-wire) serial channel, 

one RS-485 serial channel, and one synchronous CMOS serial channel. The Intellicom may 

be configured for 5-wire RS-232 or two 3-wire RS-232 channels. The exact configuration 

instructions depend on the version of Intellicom board you have. This information is 

etched on the bottom side of the printed circuit board, or you can readily determine your 

version by examining the diagrams below to find the one that matches your board.

Version 175-0188 Rev. A & B

The RS-232 transceiver may be used as a 5-wire RS-232 channel or as two 3-wire RS-232 

channels at the expense of the RS-485 channel by adding 0 Ω surface-mounted resistors at 

R61 and R62 as shown in Figure 8(a). The RS-485 chip (U10) and the associated bias and 

termination resistors (R58, R59, and R60) shown in Figure 9(a) must be removed when 

configuring the Intellicom for either one 5-wire RS-232 or two 3-wire RS-232.

Figure 8(a).  Intellicom RS-232/RS-485 Serial Communication Options

Table 2(a) summarizes the options. Note that the parameters in the serMode software 

function call must also be set to match the hardware configuration being used.

Table 2(a).  Serial Communication Configurations (Version 175-0188 Rev. A & B)

Item
One 3-wire RS-232 

& RS-485 
Two 3-wire RS-232 One 5-wire RS-232

R58–R60 In Out Out

R61–R62 Out In In

U10 In Out Out

J7-3 & J5-3 RS-485+ TxB TxB

J7-4 & J5-4 RS-485– RxB RxB

J7-6 TxC TxC RTS

J7-7 RxC RxC CTS
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Version 175-0188 Rev. C

The RS-232 transceiver may be used as a 5-wire RS-232 channel or as two 3-wire RS-232 

channels at the expense of the RS-485 channel, which is connected through 0 Ω surface-

mounted resistors at R82 and R83 as shown in Figure 8(b). R82 and R83, shown in 

Figure 8(b), must be removed when configuring the Intellicom for either one 5-wire RS-232 

or two 3-wire RS-232. U10 and the associated bias and termination resistors (R58, R59, 

and R60) must also be removed, but R82 and R83 are left installed, if you wish the TxB 

and RxB RS-232 signals to be available on header J5.

Figure 8(b).  Intellicom RS-232/RS-485 Serial Communication Options

Table 2(b) summarizes the options. Note that the parameters in the serMode software 

function call must also be set to match the hardware configuration being used.

Table 2(b).  Serial Communication Configurations (Version 175-0188 Rev. C)

Item
One 3-wire RS-232 

& RS-485 

Two 3-wire 

RS-232

One 5-wire 

RS-232

RS-232 

on J5

R58–R60 In — — Out

R61–R62 Out In In In

R82–R83 In Out Out In

U10 In In In Out

J7-3 RS-485+ TxB TxB TxB

J7-4 RS-485– RxB RxB RxB

J7-6 TxC TxC RTS TxC or RTS

J7-7 RxC RxC CTS RxC or CTS

 J5-3 RS-485+ — — TxB

J5-4 RS-485– — — RxB
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